
Solar Activity
Part 1: Observations

Introduction
In this lab you will explore structure of the solar magnetic field using visualizations of 
simulation results. 
• compare sunspot images to the magnetograms for both solar minimum and solar 

maximum cases 
• relate active regions as seen in magnetograms to those seen in Extreme Ultraviolet 

Images 
• compare the properties of active regions over the course of a solar cycle 

Sunspots and Solar Active Regions
1. Open the web browser bookmarks and click on the ‘Solar-SOHO’ link.  You will see a 

window with 5 displays.  
2. http://iswa.ccmc.gsfc.nasa.gov:8080/IswaSystemWebApp/index.jsp?

i_1=71&l_1=419&t_1=269&w_1=451&h_1=373&i_2=5&l_2=662&t_2=633&w_2=395
&h_2=427&i_3=4&l_3=218&t_3=644&w_3=417&h_3=428&i_4=137&l_4=15&t_4=25
3&w_4=388&h_4=400&i_5=139&l_5=907&t_5=261&w_5=399&h_5=409 

3. Focus on the top row first (below the ‘Available Cygnets’ menu).  On the left side is 
the white light image of the Sun, and on the right is the magnetogram image. These 
two images were taken by the SOHO spacecraft 

4. (http://sohowww.nascom.nasa.gov/). Notice the date in the lower left hand side of 
the image. The functions of this spacecraft are being replaced by the SDO 
spacecraft (http://sdo.gsfc.nasa.gov/) so the most recent data is not available.  
Historical data is available though going back over a decade. 

5. Use the ‘Global Date/Time’ feature to set the date to the first day of 2011. Compare 
the white light image to the magnetogram image. Discuss the following with your 
group.

Discuss with your group:
• What is the relationship between sunspots and magnetically active 

regions? 
• Are all sunspots associated with magnetically active regions? 
• Are all magnetically active regions associated with sunspots? 
• How does the structure of the active region differ between the northern 

and southern hemisphere? 

6. The bottom two panels show images taken by the SOHO spacecraft in the Extreme 
Ultraviolet (EUV) range for a give wavelength.  The ‘blue’ image is 171 Angstroms 
and the ‘green’ image is 195 Angstroms. Bright regions show areas where the 
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coronal plasma above the solar surface is heated to temperatures that irradiate at 
that wavelength. These are referred to as ‘active regions’. Dark regions are are 
interpreted as being ‘holes’ in the coronal where the plasma has been evacuated. 

Discuss with your group:
• How do the EUV active regions compare the the strong magnetic regions 

on the magnetogram?
• Where are the coronal holes located?  How do they correspond to the 

active regions?  
• Can you make out the coronal holes at the poles as well as at the lower 

latitudes?

7. The last panel, in the middle of the top row, shows a computer model results of the 
solar magnetic field. Model results are not available for all dates so look carefully at 
the date to make sure the results exist.

Active Regions and Coronal Holes Throughout a Solar Cycle
8. Review this page http://www.swpc.noaa.gov/SolarCycle/ on the Space Weather 

Prediction Center website to determine approximately where we are in the solar 
cycle.  You can also look at http://solarscience.msfc.nasa.gov/images/
ssn_predict_l.gif from NASA.

9. Use the ‘Global Date’ Setting to view historical data from SOHO back to 1998. 
Explore how the position and configuration of the magnetic active regions changes 
over the course of a solar cycle. (Note that the SOHO data begins during the 
approach to Solar Maximum of Solar Cycle 23 while we are currently in the rising 
phase of Solar Cycle 24.)

Discuss with your group:
• What happens to the average latitude of the active regions over the solar 

cycle? 
• What are the indicators of the beginning of a new solar cycle?  When 

does Solar Cycle 24 begin?
• Is the beginning of the solar cycle occur during solar maximum or solar 

minimum? 

10.Review the position and configuration of the coronal holes through out the solar 
cycle.

Discuss with your group: 
• Where are the coronal holes mainly located near solar minimum?  Solar 

Maximum?

Configuration of the Solar Magnetic Field
The last panel in the middle of the top row shows a computer model prediction of the 
solar magnetic field that uses the measured magnetogram as input.  We will explore this 
further in part 2.
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Viewing the Latest Data
11.Scroll through the Cygnet menu at the top of the page under the solar tab and 

search for the ‘SDO AIA 4500’ (page 5 of the solar page) data feed and the ‘SDO 
HMI’ (page 6) magnetograms.  Click on each and and arrange the windows. Also 
choose one of the SDO composite images.  Reset the global date to the current date

Discuss with your group:
• Based on these images, what is the current phase of the solar cycle?  

What are the indications you used to draw this conclusion?

The SDO version of the page we started with is at:
http://iswa.ccmc.gsfc.nasa.gov:8080/IswaSystemWebApp/index.jsp?
i_1=71&l_1=420&t_1=317&w_1=451&h_1=373&s_1=0_0_10_3&i_2=255&l_2=1&t_2=2
96&w_2=415&h_2=432&s_2=0_0_10_3&i_3=21&l_3=7&t_3=728&w_3=447&h_3=459&
s_3=0_0_10_3&i_4=251&l_4=441&t_4=717&w_4=416&h_4=443&s_4=0_0_10_3&i_5=
275&l_5=865&t_5=265&w_5=398&h_5=411&s_5=0_0_10_3&i_6=32&l_6=62&t_6=120
2&w_6=1175&h_6=305&s_6=0_0_10_3&i_7=17&l_7=853&t_7=693&w_7=425&h_7=45
8&s_7=0_0_10_3

Solar Photospheric Magnetograms and Synoptic Maps 
Magnetograms are images of the solar magnetic field at the photosphere. They are 
derived by measuring the size of line splitting due to the Zeeman Effect. (Electrons in 
the same energy level, but with different angular moment will have their energies 
changed slightly when a magnetic field is applied. This appears in the atomic spectrum 
as split spectral lines.) These magnetograms are used as the inner boundary conditions 
for coronal models such as Wang-Sheeley-Arge (WSA) and Magnetohydrodynamic 
Around a Sphere (MAS).  A current magnetogram can be found here

http://iswa.ccmc.gsfc.nasa.gov:8080/IswaSystemWebApp/index.jsp?
i_1=35&l_1=533&t_1=269&w_1=729&h_1=588&s_1=0_0_10_3&i_2=341&l_2=36&t_2=
293&w_2=500&h_2=510&s_2=0_0_10_3&i_3=353&l_3=17&t_3=317&w_3=500&h_3=5
10&s_3=0_0_10_3

The right hand image on the above link is a magnetogram synoptic map. It can be 
thought of as a projection of the solar surface onto a flat plane. All of the magnetogram 
synoptic maps are compiled from solar magnetograms such as those taken from the 
GONG network magnetogram like the ones above on the left. To construct these 
synoptic maps only the central portion of the magnetogram image is used. A series of 
such images are taken as the sun rotates and are pasted together to construct a map 
over the course of a rotation. Some weighted averaging is done for areas that overlap. 

Answer the following questions in your lab note book. 
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http://iswa.ccmc.gsfc.nasa.gov:8080/IswaSystemWebApp/index.jsp?i_1=35&l_1=533&t_1=269&w_1=729&h_1=588&s_1=0_0_10_3&i_2=341&l_2=36&t_2=293&w_2=500&h_2=510&s_2=0_0_10_3&i_3=353&l_3=17&t_3=317&w_3=500&h_3=510&s_3=0_0_10_3
http://iswa.ccmc.gsfc.nasa.gov:8080/IswaSystemWebApp/index.jsp?i_1=35&l_1=533&t_1=269&w_1=729&h_1=588&s_1=0_0_10_3&i_2=341&l_2=36&t_2=293&w_2=500&h_2=510&s_2=0_0_10_3&i_3=353&l_3=17&t_3=317&w_3=500&h_3=510&s_3=0_0_10_3
http://iswa.ccmc.gsfc.nasa.gov:8080/IswaSystemWebApp/index.jsp?i_1=35&l_1=533&t_1=269&w_1=729&h_1=588&s_1=0_0_10_3&i_2=341&l_2=36&t_2=293&w_2=500&h_2=510&s_2=0_0_10_3&i_3=353&l_3=17&t_3=317&w_3=500&h_3=510&s_3=0_0_10_3
http://iswa.ccmc.gsfc.nasa.gov:8080/IswaSystemWebApp/index.jsp?i_1=35&l_1=533&t_1=269&w_1=729&h_1=588&s_1=0_0_10_3&i_2=341&l_2=36&t_2=293&w_2=500&h_2=510&s_2=0_0_10_3&i_3=353&l_3=17&t_3=317&w_3=500&h_3=510&s_3=0_0_10_3
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For the Synoptic Map, look at the axes on all sides. Notice that the left/right and top/
bottom label pairs are different from each other. How do you interpret all the axes 
labels? 
Why might the data near the poles be suspect? 
There are two sets of dates at the top? What do you think these dates mean? (Notice 
the date on the raw magnetogram on the left. Also notice the direction that dates 
proceed on the synoptic map.) 
Which region of the raw magnetogram corresponds to the active region labeled on the 
synoptic map? (Hint: Check the dates.) 
Do the structures of the magnetogram and the synoptic map match exactly? If not, why 
not? 
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Solar Activity
Part 2: Observations

Introduction
In this lab you will explore structure of the solar magnetic field using visualizations of 
simulation results.  After this lab you should: 
• understand the structure of magnetic fields around active regions
• identify the origins of open and closed field lines
• compare the structure of the solar magnetic field at solar minimum and solar 

maximum

Getting Started
Open the “Space Weather Explorer”  (SWX) which has a link on the desktop. Use the 
File selector to navigate to the “Solar” directory. Open the “mas_cr2080.cdf” file. The 
simulation results in this file were generated using the MAS (“Magnetohydrodynamics 
around A Sphere”,  insert links ) model for Carrington Rotation (CR) 2080 near Solar 
Minimum in December of 2008. 
•
• Click the “+” button to add a surface. 
• Click the “tool” button to open the surface settings. The “R” component should be set 

with the “constant value” near “1”
• Choose the “B_r” variable to display on this surface.  “B_r” is the radial component of 

the magnet which is very near that which is extrapolated from the solar 
magnetograms. Click “ok”.

The  image should be very close to the synoptic map of the magnetogram synoptic map 
below and depicts the magnetic field near the surface of the Sun. For this model, the 
magnetograph synoptic map sets the inner boundary condition 
You can compare it to the SOHO synoptic magnetogram at 
http://soi.stanford.edu/magnetic/synoptic/carrot/M/2080/synop_Ml_0.2080.gif

Exploring the Solar Corona Solar Minimum
• In the “View” menu, click on “3D View” to see this image wrapped onto a sphere 

representing the solar surface magnetic field. 
• You can rotate the image by using “click in drag” and zoom out using the mouse 

wheel.

1. What general conclusions can you draw about the magnetic field at the 
surface of the sun during Solar Minimum? Is there a magnetic active region?
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2. Draw what you think the solar magnetic field should look like in this case, and 
discuss it with your group.

3. What is the configuration of the field near the poles?
4. ... near the active regions?

You can choose some field lines by clicking on the solar surface in the original window.
• Start by clicking on field lines near the active region.  
1. What is the configuration of those lines? Do all the lines do the same thing?
• Click on lines near the poles.  
1. What is the configuration fore these lines?How does this compare to you 

predictions above?
2. For field lines that begin and end on the surface of the sun, what can you say 

about the relative polarity of the foot points? 
3. Approximately, what is the furthest extent that closed field lines extend out 

from the Sun?

Clicking on the map provides seed points from which field lines are drawn. We can also 
import set of seed points from a text file. To explore the magnetic field more carefully, 
we can import a “regular” set of seed points.
• From the “View” menu, click on “Seed Points”.
• To remove the points you have chosen click on “Remove all”
• Click the “Import” button and navigate to the “Solar” directory. The .csv files in this 

directory are text files with regularly spaced seed points. Choose “Global-1.5Rs.csv” to 
plot seed points starting at 1.5 solar radii.  Click “ok” and hit the “Go” button on the 2D 
map. You may have to reopen the 3D view to see the field lines.
๏What generalizations can you make about the origin of “open” and “closed” 

field lines?
๏Where do most of the field lines that reach the boundary originate from? 
๏Where do most of the “closed field lines” originate from?

Solar Maximum (Homework)
The example we will use for solar maximum is from CR 1965 which occurred during the 
last solar maximum, July of 2000. 
• Use the “File” menu to navigate to the “mas_cr1960.cdf” file in the Solar directory.  
• IncluClear the seed positions.

๏What do you notice about the number and position of the magnetic active 
regions?

๏Draw what you think the solar magnetic field might look like for this CR. 
• Click on a few points on the map and explore the magnetic field structure. 

๏What conclusions can you draw about the structure of the closed field lines?  
Is it a regular structure? Do closed field lines only connect from one pole of 
an active region to the other pole of the same active region?

๏What about open field lines?  Where do they originate?
• Confirm your conclusions by using the regular seed points at 1.5 Rs and 28 Rs
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Conclusion
Open field lines that reach out into the heliosphere tend to originate from coronal holes 
where much of the solar wind originates.

๏What conclusions can you draw about the source of the solar wind at solar 
minimum and solar maximum?  At what latitudes does the solar wind 
originate from on the Sun?

• Return to the iSWA window.
http://iswa.ccmc.gsfc.nasa.gov:8080/IswaSystemWebApp/index.jsp?
i_1=71&l_1=419&t_1=269&w_1=451&h_1=373&i_2=5&l_2=662&t_2=633&w_2=395&
h_2=427&i_3=4&l_3=218&t_3=644&w_3=417&h_3=428&i_4=137&l_4=15&t_4=253&
w_4=388&h_4=400&i_5=139&l_5=907&t_5=261&w_5=399&h_5=409

• Choose a date near the Solar minimum case above near December of 2008. Notice 
the model output in the middle of the screen.  This model is the (PSFF) model. 
๏Are the field lines shown here consistent with what you saw in the MAS 

model? 
๏What conclusions can you draw about the relationship between the “coronal 

holes” seen in the SOHO EIT (Extreme Ultraviolet Images).
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http://iswa.ccmc.gsfc.nasa.gov:8080/IswaSystemWebApp/index.jsp?i_1=71&l_1=419&t_1=269&w_1=451&h_1=373&i_2=5&l_2=662&t_2=633&w_2=395&h_2=427&i_3=4&l_3=218&t_3=644&w_3=417&h_3=428&i_4=137&l_4=15&t_4=253&w_4=388&h_4=400&i_5=139&l_5=907&t_5=261&w_5=399&h_5=409
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